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Top Tips for Effective Presentations

How can you make a good presentation even more effective?

This page draws on published advice from expert presenters around the world, which will help to take your
presentations from merely ‘good’ to ‘great’.

Show your Passion and Connect with your Audience
Focus on your Audience’s Needs

Keep it Simple: Concentrate on your Core Message
Smile and Make Eye Contact with your Audience
Start Strongly

Remember the 10-20-30 Rule for Slideshows

Tell Stories

Use your Voice Effectively

Use your Body Too

Relax, Breathe and Enjoy
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Remember Law School

* You were constantly
writing whether it was in a
notebook, on a computer, or
in a Blue Book

* Your writing was intended
to engage and persuade



This is your

Target
Audience




Because Your Audience
is @ Criminal Defense
Attorney

An Effective Paper is
Critical in Your
Preparation and
Presentation

Good wIriting
1S clear

thinking made

visible.

Bill Wheeler
An Effective Paper Allows You More
Freedom in Your Presentation
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Clear Concise
Four C’s of
Communication
Complete Correct

Writing Has Always Been Our Most

Universal Form of Communication




Tell me and I
What Does Good Writing Look Like? forget. Teach me

and I remember.

Involve me and 1

learn.
* Good Writing is a result of Good Thinking

* Improve your thought process you will BEN FRANKLIN
improve your writing

* Good Writing necessarily improves your
thinking

e Re-write and edit multiple times
* Being perfect is not your goal

* Being thorough and accurate is the goal



v’ Ideas that are mterestmg
and important.

v’ Organization that is :':-““f{
logical and effective. R

v’ Voice that is individual a

and appropriate.

v’ Word Choice that is %
specific and memorable. <€

v’ Sentence Fluency that. &
is smooth and mu5|cal »'EJ

v’ Conventions that are @«
correct and communicative. e ls°




It's not about
fuawing the time.

It's about
matzing the time.

* You Will Get Feedback on Your Paper and Presentation
* There is always someone determined to criticize your work
* Don’t give them a reason




gettmg ahead
1S getting
started.”

- Mark Twain
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Pre-Writing Techniques

' : How do you organize your ideas when
| o Youarepreparing to write?

: : @ Brainstorming @ Listing
=#® @Discussing @ Qutlining
:‘ : @ Free Writing @ Charting

=® @Looping © Mapping
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Bubble Map Graphic Organizers Worksheet




Outline for Descriptive Essay

Paragraph 1

a. Opening Topic Sentence/Attention Getter
b. The Place I am writing about

c. Brief feeling about the place

d. Sensory Detail

Paragraph II
a. Description of another specific location within the
same place
b. Factual Details
¢. Sensory Detail with vivid language

Paragraph III
a. Description of another specific location within the
same place
b. Factual Details
c¢. Sensory Detail with vivid language

Paragraph IV
a. Restatement of feeling about place with further
expansion
b. Additional Details
¢. Clincher statement










Thinking Like a Lawyer

® What caused the problem/
raised the question?

® What are the legal rules
governing the issues?

® How does the law apply to
the specific fact pattern?

® Distinguishing

Writing Like an Efficient
Writer

® Deep issue analysis: Q&A
then Why

® Summarize efficiently,
prioritize and remove non
Issues

® Break down the issue into
multiple sentences




How Do You Think?
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ANALYTICAL O
Ability to analyze

things first CREATIVE THINKING

OPEN-MINDED
Thinking of things no
one else has considered
before

PROBLEM SOLVING

Ability to solve an
important issue o ®

PO P |

[

ORGANIZATION

Being able to structure

a plan of action with clear
goals and deadlines

9 )

COMMUNICATION
Strong written and oral
skills, ability to listen and
ask the right questions




Reasoning

/-\ .« Problem

Analyzing ' Cl'ltlcal Solvin g

Thinking
Skills

Decision

Making Evaluating




Creative Thinking

Openness to novelty
Idea generation
Curiosity

Invention

Imagination

Divergent thinking
Playfulness

Reasoning by metaphor
and analogy

Problem - Solving

Elaboration

Synthesis, Integration and
combination

Complexity
Abstraction and simplification

Awareness of Environment

AN EFFECTIVE
PAPER
REQUIRES BOTH
SIDES OF YOUR
BRAIN

Critical Thinking

Evaluation and
assessment

Categorisation
and classification

Reasoning
through logic

Identification
Interpretation

Analysis




The IRAC Method

» Issue

» Identify and state the legal issue presented by the
fact scenario. (1-2 sentences)

= Rule
m State/define the legal principle that applies to the
issue.
= Analysis
» Discuss how the legal principle relates to the fact

scenario. This should be the most lengthy portion of
your answer.

= Conclusion

m State your conclusion based on your analysis. (1-2
sentences)
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What is Expository Writing?

» Expository writing is defined as presenting
reasons, explanations, or steps in a process

» Informational writing

» An expository essay should follow a logical
sequence and have three different main
points

» Logic and coherence is the main focus of an
expository essay




Characteristics of Good
Expository Writing

e Use M that

e Focus on main topic.

e Use logical,
supporting facts.

e Give sufficient
details, explanations,
and examples.

e Make sure your ideas
are clear and precise.

e Use smooth
transitions.

e Do not assume
reader has prior
knowledge of the
topic.

e Present ideas in a
logical order.

e Use strong
organization.




Persuasive

Essentials

¢ Identify topic & position

Explain what you want or what you believe

¢ List many good reasons

Provide solid support for why you are right

e Organize key points

" Order your reasons to end with your best

=z End with what you want

" Tell readers what you expect them to do

s Express your attitude

Reveal your feelings & point of view

¢~ Employ exact words

" Select precise words to convince the reader




Persuasive Writing Checklist

\\ Introductory paragraph - state the argument.

\\ Use words such as...

Some believe that... In my opinion... Therefore... Moreover...
For this reason... | feel that... Surely... | am sure that... It is certain...

\\ Evidence - say why your viewpo'mt is right. Facts!

s
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“ Give reasons for and against. |

\\ Ask questions to get the reader think'mg.@







Take time to
brainstorm

It is important
that before
writing the
descriptive

essay you have
to describe your
topic first.

Use Images

Language is
important in
descriptive
language. This
means that you
choose the words
carefully.

Use clear and
concise language

Language is important
in descriptive
language. This means
that you choose the
words carefully.

Use your
senses

Senses are
important if you
writing a descriptive
essay. If you are
describing
something, you need
to be appealing to
the senses of the
reader.




Narrative

Essentials

X Create a basic plot

Make something happen to someone

= HOOK & satisfy readers
" Start & end the story intentionally

wn S€QUeENce time & events

T Connect action with transitions

Describe the action

= Use sensory details to develop key moments

o 'Show” close-up details

e Describe main character(s) & setting(s)

g Settheright mood

Reveal character feelings & setting tone




Narrative Writing

Should be familiar because it is
generally how we argue to the

jury




Format
Single Versus Double Columns

International Joumal of Scientific and Rescarch Publications 1
1SSN 2250-3183

Title for paper submitted to International Journal of
Scientific and Research Publications

irst Author’, Second Author”, Third Author™

* Department, Institute Name
Department, Institute Name, if any

Abstract- Mention the abstract for the article. An abstract is a brief summary of a research article, thesis, review, conference
proceoding orany in-depth asalyis of 8 pnicular subjec or discipline, and s ofen sed t help th reade quickly ssnsin the
paper's purpose. W . an abstract always appears at the beginning of a manuscript, acting as the point-of-entry for any
Scentifc paper or patent application.

Index Terms- About four key words or phrases in alphabetical order, separated by commas. Keywords are used to retrieve documents
in an information system such as an online journal or a search engine. (Mention 4-5 keywords)

I INTRODUCTION
his article guides a stepwise mmx.mug\ by Experts for writing a successful journal or a rescarch paper starting from inception of
ideas till their publications. Research papers arc highly recognized in scholar fraternity and form a core part of PhD curriculum.
Research scholars publish their research ork in leading journals to complete their grades. In addition, the published research work
also provides a big weight-age to get admissions in reputed varsity. Now, here we enlist the proven steps to publish the research paper
ina journal.

Identify the constru
upon the topic of
1) Abstract
2)  Introduction
3) Rescarch Elaborations
4) Results or Finding
5) Conclusions

of a Journal — Essentially a journal consists of five major sections. The number of pages may vary depending
arch work but generally comprises up to 5 to 7 pages. These are:

In Introduction you can mention the introduction about your research.

1I. IDENTIFY, RESEARCH AND COLLECT IDEA
1t's the foremost preliminary step for proceeding with any research work writing. While doing this go through a complete thought
process of your Journal subject and research for it's viability by following means:
1) Read already published work in the same field.
2) Goggling on the topic of your research work
3)  Attend conferences, workshops and symposiums on the same fields or on related counterparts.
4) Understand the scientific terms and jargon related to your rescarch work.

I, WRITE DOWN YOUR STUDIES AND FINDINGS
Now it is the time to articulate the research work with ideas gathered in above steps by adopting any of below suitable approaches:

A. Bits and Pieces together

In this approach combine all your researched information in form of a journal or research paper. In this rescarcher can take the
reference of already accomplished work as a starting building block of its paper.

Jump Start

“This approach works the best in guidance of fellow rescarchers. In this the authors continuously receives or asks inputs from their
fellows. It enriches the information pool of your paper with expert comments or up gradations. And the researcher feels confident
about their work and takes a jump to start the paper writing.

HIS LINE WITH YOUR PAPER IDENTIFICATION NUMBER (DOUBLE-CLICK HERE TO EDIT) 1

[Report Title]

[Author Narme]. [Author Name], and [Atthot Name]. Member, IEEE

Abstrac—This template for a_double-column paper was
created for the book Technical Writing for Teams: The STREAM
Tools Handbook according to the instructions for authors
contributing papers to the disciplines of the Institute of Electrical
and Electronics Engineers (IEEE). The original n.mylm
provided by the TEEE does not have automated typesetti
Tunctions. This, TEEE. Auto template file is preformatted for
automatic numbering of manuscript elements. 1t should be easy
to adjust appearance settings (for example, column width), to
meet the requirements of other publishers.

Index Terms—About four key words or phrases in
alphabetical order, separated by commas. For a list of suggested
Keywords, send a blank e-mal to kevwords@iece.org or visit the
TEEE web site

http:/www eee.or bs/ani_prod/keywrd98.tx
t

I INTRODUCTION
HIS document is a template for Microsoft Word versions
140 or later, designed according 1o the IEEE template

TRANS-JOURDOC, available from the IEEE website

http:/www ieee.or lesheet

adjust your fonts and line spacing. Do not change the font
sizes or line spacing to squeeze more text into a limited
number of pages. Use italics for emphasis; do not underline

To insert images into Word, position the cursor at the
insertion point and either use Insert | Picture | From File or
copy the image to the Windows clipboard and then Edit | Paste
Special | Pioture (with “Float over text” unchecked)

IEEE will do the final formatting of your paper. If your
paper is intended for a conference, please observe the
conference page limits

1. PROCEDURE FOR PAPER SUBMISSION
Review Stage

Please check with your editor on whether to submit your
‘manuscript by hard copy or electronically for review. If hard
copy. submit photacopies such that only one column appears
per page. This will give your referees plenty of room to write
comments. Send the number of copies specified by your editor
(typically fout] If submitied electronically, find out if your
ail attachments.
want 1o submil your file with one. column

shim so you can use it o prepare your manuscript

When you open DoubleColumn_ Template 2012 docx,
select “Page Layout” from the “View” menu in the menu bar
(View | Page Layout), which allows you to see the footnates
Then type over the section of the anuscript and copy the
templates of individual manuscript elements to create new
elements, such as figures or equations.

The pull-down style menu is at the left of the Formatting
Toolbar at the top of your Word window (for example, the
style at this point in the document is “Text”). Highlight a
section that you want to designate with a certain style, then
select the appropriate name on the style menu. The style will

Manuscript received [Octaber 9, 2012]. (Write the date on whidh you
ubmitted your paper for eview.) This work was supported i part by the U.S.
Depattmant of Commerce under Orant BS12456 (ponsor wd fomcil
mpport seaemlodgmanl goce . Prpar s shouid be mitien n
Uppercan 4ad knmecase ‘B, . A3, sgpwramn, Avoid wriing ing
Trmaias with sobacits i the G Shotfortutes that ey the clements
arc finc {c.g., "Nd-Fe-B"). Do nol write "(nvited)" in the tile. Full names of
authors are preferred in the author field, but are not required. Put a space
between authors iniials
Author is wilh the National Institute of Standards and Technology.
Boulder, CO S130S USA (comespning stho 0 rovide phone: 035
fix: ‘cmail: authon@ boulder nis gor
S b, . e Rice Univesay, Houston, T 77005 USA. He
is now with the Department of Physics, Colorado State University. Fort
Collins, CO 80523 USA (e-mail: auhor@lamar. colostate.edu).
. C. Ao s wit he ElecticalEngiccring Deparnent, Universiy of
Colorado, Boulder, CO 80309 USA. on leave from the National Rescarch
e for Metas. Takuba, (st it Sy

y, please do the following:
First, click on the View menu and choose Print Layout
Second, place your cursor in the first paragraph. Go to
the Format menu, choose Columns, choose one column
Layout, and choose “apply to whole document” from the
dropdown menu

~-Third, click and drag the right margin bar to just over 4
inches in widl
The graphics will stay in the “second” column, but you can
drag them to the first column. Make the graphic wider to push
outany text that may try to fill in next to the graphic.

B. Final Stage

When you submit your final version, after your paper has
been accepted, print it in two-column format, including figures
and tables. Send three prints of the paper; two will go to IEEE
and one will be retained by the Editor-in-Chief or conference
publications chair.

You must also send your final manuscript on a disk, which
IEEE will use to prepare your paper for publication. Write the
authors’ names on the disk label. If you are using a Macintosh.
please save your file on a PC formatted disk, if possible. You
may use Zip or CD-ROM disks for large files. or compress
files using Compress, Pkzip, Stuffit, or Gzip.

Also send a sheet of paper with complete contact
information for all suthors. Include full mailing addresses.
telephone numbers, fax numbers, and e-mail addresses. This




* Personal Choice
* 12 Point Font is preferred

 Garamond, Calibri, Times New
Roman, Serif, and Courier are the
most frequently used

* Your Font selection should be
something the reader has seen
before

* You want your reader
comfortable and not wondering
why you chose that particular
Font

APCDEFGHIJKLM
JOPQRATUYWXYZ
abedgfmiikim
hbpc[rbtm[ YN
042315678917



Proper Legal Citations are Absolutely Critical for an Effective Paper

THE

THE S BLUEB
GREENBOOK BLUEBOOK T

Tean Ru |eS Of Form A Uniform System of Citation®

Twentieth Edition







Grammar vs Punctuation

Grammar is used both
written and spoken
language.

Grammar studies how words
change their forms and combine
with other words to make

A sentences.
Grammar is a set of

rules.

A sentence has to have
correct grammar and
punctuation, in order to be
called an 'accurate sentence'.

Both add sense and clarity
to a sentence.

Punctuation is a set of
Punctuation is more symbols.

noticeable in written
language.

Punctuation seperates a text
in to sentences, clause and

phrases.
Pediaa.com




Active Voice Passive Voice

Subject Subject

Sally drove her car off of the road. The car was driven off the road by Sally.

The dog bit Timmy on the arm. Timmy was bitten on the arm by the dog.




"

TENSE
Present Simple

Present Contin.

Past Simple

Past Continuous
Present Perfect
Past Perfect
Future Simple
Future be going to
Modal

Modal Perfect

ACTIVE

| make a cake
I'm making a cake

| made a cake.

| was making a cake.

| have made a cake

| had made a cake.

| will make a cake.

I’'m going to make a cake.
| must make a cake.

| should have made a
cake.

PASSIVE

A cake is made
A cake is being made.

A cake was made.

A cake was being made.
A cake has been made.

A cake had been made.

A cake will be made.

A cake is going to be made.
A cake must be made.

A cake should have been
made.



Why do we use the passive voice!

_ We don’t know the subject

2. The subject is not important or we don't
want to mention it .

| We want to talk about the object and not
the doer (subject) of the actlon |



Passive Voice

We use passive forms when:
m3) we don t know WHO did it;
The window was broken an hour ago.

mh) we are interested in WHAT happens, not WHO it
Is done by;

His watch was stolen in the street.
mc) the situation Is rather formal.
Smoking is not allowed.




* Don’t Repeat Yourself

* You will Lose Your Audience

Top 50 Redundant Words and Phrases to Avoid in Your Writing

A total of
Absolutely certain
Actually
All things being equal
Appears to be
As a matter of fact
As far as | am concerned
As opposed to
At the end of the day
At this moment in time
Basically
Current/Currently

Each and every one

Everything else being equal

Extremely
Greatly
Fairly unique
I am of the opinion that

I would like to say

1 would like to take this opportunity to

In due course
In fact
In the end
In total
In view of the fact that

| personally
It should be understood
Last but not least
Like/Likely
Literally
Needless to say
No doubt
Nonetheless
Obviously
Of course
Quite
Really
Really quite
Seems to be
Somewhat
That
The fact of the matter is
To all intents and purposes
To my mind
Truly
Until such time as
Very/Very much so
Well/Well actually
With due respect
With regards to

© www.proofeditwrite.com




Keep it Simple

Less is More
&

You Will Keep the Reader
Engaged

YES (shorter words) NO (longer words)
Use Utilize

Take part Participate

Expect Anticipate

So According

About Approximate

Size Magnitude




That Introdue




INTRODUCTORY PARAGRAPH

-Beg\r\s With |- sentence ATTENTION

GRABBER — makes reader Wank 1o read
Ly one ok Hhe Rllowing: secies of
questions, anecdore, stactling|
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= thesis shobement




Introductory Paragraph

4 Se ntence ] ¥ HOOk (either an anecdote, conversation, fact, statistic,

quotation, exaggerated information, question)

» Sentence 2: Topic Sentence (el what the topicis)
» Sentence 3: Thesis Statement el your position on the topic)
» Sentence 4: Rainbow Sentence (reasons that support your

thesis)

4 Sentence 5: TranSitiOn Sentence (leads to your body
paragraph)




. ¥ . .
CH mser}ipace the[carlred]  january is a month

PGSSiV@ Ton}\Dick and Han'&a Summel IS 2 season

Proofreading and Editing

pages 14257 Drelete-the-entive-dine-O ?

Ww something X
. P [Not a sentence. Insert/{lexe delete awk

Proofread and
Edit Numerous
Times

Get a Fresh Set of
Eyes to Help



WRITE THAT ARTICLE FOR THE VOICE



VOICE

FOR THE DEFENSE

TURNING THAT PAPER INTO A VOICE ArTICLE




READABILITY




Current Voice Guidelines

* 500 to 2,500 Words




Either write something
“worth reading or do

'something worth
' writing.

Benjamin Franklin




